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INTRODUCTION: WHAT TO DO NOW
Once your title has been registered the next steps of your review preparation is as follows: 

1. Download and install RevMan 5.1 software (see later in this Chapter). 
2. Respond to the system-generated email to initiate your Archie account (new authors).  

3. Set up RevMan so it can connect with the Archie server where reviews are stored (by entering your Archie account details into the Tools>Preferences>Connections settings).
4. Check your protocol file out of Archie and into RevMan. To do this open RevMan 5 > File > Check out.... Choose the protocol or review you wish to work on from those available to you in the list. Please remember to check in at the end of every work session. Note: You can only check your review in to Archie from RevMan 5 if the version you edited was checked out from Archie. All previous versions of the review will be retained on Archie.
5. Prepare your protocol within the RevMan 5.1 software (see especially the Cochrane Handbook, and Chapters 2 and 3 of this resource pack).  

6. You can share versions of the protocol with co-authors by checking it back into Archie and emailing your co-authors to let them know they can now view your version in Archie.  Please do not share versions of the protocol with co-authors by emailing RevMan files. 
7. When the protocol is ready, submit it for editorial and peer review: 

· Use File > Check in to open the Check-in Wizard in RevMan 5.1
· Describe the version (e.g., ‘your name’ edits)

· Check the ‘Submit for editorial approval’ and enter text in the ‘Message to Cochrane Review Group’ box to communicate with me about your submission. This replaces a message you would otherwise have sent in an email.
· If this is the first time you are submitting the protocol, complete the presubmission checklist (http://www.latrobe.edu.au/chcp/cochrane/resources.html) and email it to Megan Prictor (m.prictor@latrobe.edu.au)
8. If necessary, in a separate Word document outline your response to each item of editorial feedback provided at title registration stage which was to be dealt with at protocol stage, indicating any action you have taken in relation to your protocol, and email it to the Managing Editor when you submit your draft protocol for editorial review and approval.

The editorial process

The process that will take place once you submit your protocol for editorial review is as follows:

1. The protocol will be sent to three editors of the Cochrane Consumers and Communication Group, to the Group’s statistical editor or research officer, and to at least three external peer referees (including one consumer). It will take about five weeks for the editors and external peer referees to review the protocol and send comments back to the editorial office. The comments will be collated by your contact editor.  

2. The editors’ comments will be sent to you and you will be asked to address these comments and submit a revised protocol and a formal response to the editors’ comments. 
3. Once the protocol is revised to the satisfaction of your contact editor, they will make a recommendation to the Review Group’s Coordinating Editor that the protocol be approved for publication. At that point the protocol will be copy edited at the editorial base and then submitted to the Coordinating Editor for approval to publish the protocol on The Cochrane Library. You will be sent the final version for your approval prior to publication.

4. You and all co-authors are required to sign Declaration of Interest and Permission to Publish forms before the protocol can be published. These will be sent to you at the appropriate time.  
5. Once the protocol is accepted for publication, you will receive further communication from us that will outline the steps for the preparation of your review and include your third resource pack.

CHAPTER 1: GETTING REVMAN SOFTWARE AND AN ARCHIE ACCOUNT

The Cochrane Collaboration uses software developed for its own purpose. You must use this software to prepare and submit your protocol and review. The software is free to Cochrane review authors.  
Download the latest version of RevMan 5.1 software from 
http://ims.cochrane.org/revman 
When using RevMan, you will need an Archie user account to check your protocol in and out from Archie, the Collaboration’s main server. We ask that you check in at the end of every work session to ensure that the most up to date version is always available online so you or your co-authors can access it wherever and whenever you need it, as well as to ensure there’s no confusion with version control. To request a user account go to http://archie.cochrane.org and select ‘Request a user account’, or email m.prictor@latrobe.edu.au
Connecting RevMan 5 to the online server Archie

To allow RevMan to communicate with the Archie online server you will need to do the following: 

Open up RevMan 5 and go to Tools/Preferences and then click on the ‘connection’ tab. Please choose the Archie server (not the test or training server), then type in your Archie username and password. If this is your own computer click ‘save username and password when RevMan is closed’, if it is a shared computer and you do this, other people who may be using RevMan mayl be checking in and out using your Archie user account. If you have problems gaining access you may need to contact your IT department to resolve any issues regarding the proxy address and port.

If you click on the other tabs under tools/preferences we also advise that you check for updates ‘every session’ and click on the warnings on the general page as well as making your choices on the spell checking tab.

RevMan training and support

A user guide and self-training exercise are available via the Help Menu in RevMan 5.  More information is also available at the following site: http://ims.cochrane.org/revman/documentation which we recommend you work through before starting to work on your protocol. RevMan training may form part of the training for review authors provided (usually at no charge) by regional Cochrane Centres (see Chapter 3 for more details).  

Requests for technical and general support should be directed to the Managing Editor (m.prictor@latrobe.edu.au) in the first instance.

Another option is to post questions on the RevMan discussion list, and wait and see what replies or suggestions appear. Visit www.cochrane.org/admin/maillist.htm#REVMAN for more information about this list. 

CHAPTER 2: HOW SHOULD A COCHRANE PROTOCOL BE PREPARED?
The aim of a Cochrane review is to assess systematically and thoroughly the best possible scientific evidence about the effects of a healthcare intervention(s). Everything about the review should aim to minimise the possibility of ending in a biased conclusion. So that means:

· the conduct of the review and its analyses should follow clear, pre-specified criteria - with checks along the way;
· it should be easy to understand;
· any conflict of interest of the people doing the review should be declared;
· effort must be made to find every possible study that might be eligible for the review;
· the studies included in the review’s final analyses should be ones which have as little bias in them as possible;
· outcomes that are important to the consumers of the interventions must be considered - whether or not they have been measured by researchers - to avoid conclusions being based on a narrow picture;
· the final review should follow the pre-specified criteria, addressing all the important issues originally raised, and highlight any issues and gaps in the information that should be addressed by researchers in future.
Cochrane reviews are published on The Cochrane Library, can be commented on by anyone, and can be corrected or have new research added in future issues. The Cochrane Library is re-issued on a monthly basis.
As a rough guide, your protocol will need to address the following issues:

1.
The specific purpose (question to be answered) of the review.
2.
The types of participants, intervention and outcome measures.
3. 
Explicit criteria for deciding which studies to include in the review.
4.
A comprehensive MEDLINE search strategy.
5.
Avoidance of bias in the selection of articles.
6.
Criteria for assessing the quality of the studies.
7.
Methods (whether qualitative or quantitative) for combining the findings.
A protocol has several sections (outlined below), which are kept as the introductory parts of the final review. The text of a protocol ends after the Methods section. Please see the introductory ‘Key Points’ at the start of Chapter 4 of the Cochrane Handbook – the handbook is available online, as a book published by Wiley, and as individual Chapters available as PDFs through Archie. To access the PDFs of the individual chapters: look at the left hand side tree view in Archie and ensure the icon above the tree view is set to ‘show all entities’ then go to Other/Handbook Editorial Advisory Panel/Files/Cochrane Handbook for Systematic Reviews of Interventions and you will see all the various Chapters listed. To download a copy of the Chapter right click on the Chapter and click on ‘download’. For writing up both your protocol and review you should find Chapter 4 particularly helpful in checking what should be included under each section.
Title:
The name of the review should properly reflect the subject of the review, and it should be easy to understand. It should also fit the standard format for review titles, as specified in the Cochrane Handbook chapter 4.2. If you plan to alter the title of your review since it was approved by the Review Group at title registration stage, please discuss and agree this with the Managing Editor.

Background:
See the Cochrane Handbook chapter 4.5.
The background should explain the topic being reviewed, and the intervention(s) of interest. The background should make the motivation and rationale for the review clear. The background section is designed to explain to people what is going to be reviewed and why. The author must explain why the question asked is important to answer. For example, it should indicate the areas of uncertainty in relation to the intervention and highlight issues that are controversial or the subject of public concern. All terms and interventions must be clearly defined, and the background must use a balanced tone that does not pre-judge the value of the intervention.

The background should be brief, up to a few pages long. It is not a monograph or an overview and should be concise and clear. Recommended subheadings are given below and these sections are described in more detail in the Cochrane Handbook section 4.5: 
· Description of the condition or problem.
· Description of the intervention.
· How the intervention might work.
· Why it is important to do this review

If you are proposing particular subgroups for analysis (under the Protocol’s Methods section), we suggest that these subgroups should be mentioned (with a rationale given) in the background section.  
Objectives:
This should begin with a precise statement of the primary objective of the review, ideally in a single sentence. Where possible the style should be of the form “To assess the effects of [intervention or comparison] for [health problem] for/in [types of people, disease or problem and setting if specified]”. This might be followed by a series of specific objectives relating to different participant groups, different comparisons of interventions or different outcome measures. It is not necessary to state specific hypotheses.
Refer to the Cochrane Handbook chapter 4.5.
METHODS
There are a number of key sections under the broad METHODS heading. Refer to the Cochrane Handbook chapter 4.5.
Please also consider the items on the Cochrane Equity Checklist
 http://equity.cochrane.org/Files/equitychecklist.pdf  Consider in advance whether issues of equity and relevant of evidence to specific populations are important to the review, and plan for appropriate methods to address them if they are. 
Criteria for considering studies for this review:

Refer to the Cochrane Handbook chapter 4.5 and chapter 5.
This section has several parts. Together, they should make it clear which studies can be included in the review, and which will not be eligible. The aim is to come up with very specific guidelines for deciding whether a study addresses the objective of the review. This section is supposed to make the reasons for including a study so clear, that anyone else could come along, apply the criteria, and come to more or less the same decisions. Later, the quality of studies that make it past this first test will also be assessed.

Please note that the heading “Criteria for considering studies for this review” is followed immediately by the next subheading, and cannot have free text after it.

This section includes:

Type of studies: This specifies the design of the studies that will be eligible - usually controlled trials. The aim is to include study designs which minimise the chances of the results being biased. Bias is something that introduces a difference or trend that distorts (or could distort) the results. Bias is a systematic error that will run through the study, because what is observed may not be the effect of the intervention, but an effect of bias instead. An example is when everybody knows they have received a new “breakthrough” treatment - just knowing that might make people feel better, while the people who “missed out” might be very dissatisfied and feel worse because of it.

Authors must refer to the Review Group’s Study Design Guide (available at www.latrobe.edu.au/cochrane/resources.html), as well chapter 4.5 and chapter 5 of the Cochrane Handbook, in preparing this section.  

Authors must define in advance the eligibility criteria for study designs in a clear and unambiguous way.  They must justify the choice of study designs (whether they have restricted the review to randomized trials or included non-randomized studies), with regard to appropriateness of the study design to the review question, and the potential for bias.  
Type of participants: This needs to state which groups of people can be included in any studies. For example, some reviews might be looking only at children or people over a particular age. Or they might be looking only at people with a specific disease, of a particular severity (for example, a particular level of high blood pressure). It can be important to consider and state the age range which you will include.
The eligibility criteria for participants must be defined clearly.  Considerations when specifying participants include setting, diagnosis or definition of condition, and demographic factors.  Any restrictions to study populations must be based on a sound rationale. 

Authors must define in advance how studies that include only a subset of relevant participants will be handled.  

See chapter 4.5 and chapter 5 of the Cochrane Handbook.

Type of interventions: The interventions and comparator interventions must be defined clearly.  Any restrictions on interventions and comparators, such as regarding delivery, dose duration, intensity, co-interventions and features of complex interventions should be pre-defined and explained.  

See chapter 4.5 and chapter 5 of the Cochrane Handbook.
Type of outcomes: The outcomes that the authors are going to look for in each study should be listed here. This should include the most important outcomes that need to be considered to make decisions about the particular intervention. These need to be specified ahead of time. The studies may not address particular outcomes, in which case it is important for the authors to know that important topics have been overlooked.

Authors should draw upon relevant literature in their field to identify important outcomes, as well as utilizing the Consumers and Communication Review Group’s taxonomy for this purpose. (www.latrobe.edu.au/chcp/assets/downloads/Outcomes.pdf). 
Authors should keep the total number of outcomes selected for inclusion in the review as small as possible, avoiding trivial outcomes and interim and process outcomes.  Choose outcomes that are relevant to stakeholders.  Large numbers of outcomes, while sometimes necessary, can make reviews unfocussed, unmanageable for the user, and prone to selective outcome reporting bias.  

Authors should define in advance details or what are acceptable outcome measures (eg. Diagnostic criteria, scales, composite outcomes). 

Authors should define in advance how outcome measures will be selected where there are several possible measures (eg. Multiple definitions, assessors or scales), and give a rationale. They must also clarify in advance whether the listed outcomes are used as criteria for including studies.  

See chapter 4.5, chapter 5 and chapter 7 of the Cochrane Handbook. Recommended subheadings, which can be ‘activated’ in the left hand side tree view within RevMan 5, are: 
· Primary outcomes.
· These should be as few as possible, and should normally reflect at least one potential benefit and at least one potential area of harm.  It is expected that the review should be able to synthesize these outcomes if eligible studies are identified and that the conclusions of the review will be based in large part on the effects of the interventions on these outcomes.  

· Secondary outcomes.
 

The following optional headings may be helpful, as supplements or replacements for the headings above: 

· Main outcomes for ‘Summary of findings’ table.
· The Summary of Findings table should include the essential outcomes for decision making (typically up to seven) which should generally not include surrogate or interim outcomes.  The outcomes should not be chosen on the basis of any anticipated or observed magnitude of effect, or because they are likely to have been addressed in the studies to be reviewed.  See chapter 11.5 of the Cochrane Handbook. 
· Timing of outcome assessment.
· Authors should define in advance the timing of outcome measurement; will all time frames, or only selected time-points be included in the review? 
· Adverse outcomes.
· Economic data.
Search methods for identification of studies:
This section shows how and where the authors will find the studies that could be eligible for inclusion in their review. Refer to the Cochrane Handbook chapter 4.5 and chapter 6.

Sources of trials

The Group’s Trials Search Coordinator can search the Cochrane Consumer and Communication Specialised Register for relevant trials for your review, on request (email m.prictor@latrobe.edu.au). Review authors should also search the Cochrane Central Register of Controlled Trials (CENTRAL) on The Cochrane Library, MEDLINE and any other relevant databases for eligible trials. You should contact researchers who are working in the area for details of any trials they may be involved in or be aware of. Searching should also include searching the reference lists of any relevant reviews or other studies, scanning paper issues of journals relevant to your topic and scanning abstracts from relevant conference proceedings. Other grey literature (eg. dissertations and theses), can also be an important source of trial data. Finally, online trials registers can be searched through central sites such as TrialsCentralTM (www.trialscentral.org), ClinicalTrials.gov, the WHO Clinical Trial Search Portal (http://apps.who.int/trialsearch/) and Current Controlled Trials (www.controlled-trials.com). 

The aim of such a thorough search is to ensure that, to the extent it is possible, all trials in the area, both published and unpublished, are identified. 

Databases

Various databases need to be searched for slightly different reasons as each has slightly different content. The following is an outline of what is contained in each:

Consumers and Communication Review Group Specialised Register: the Review Group uses a broad search strategy to locate randomised controlled trials (RCTs) and controlled clinical trials (CCTs) from the Cochrane Central Register of Controlled Trials (CENTRAL, The Cochrane Library) and other sources that are relevant to the Group in the broadest sense, i.e. communication between consumers and healthcare providers across all health fields or topics.  The Register is held at the Review Group’s editorial base and can be searched by the Review Group staff upon request (see process below).

Cochrane Central Register of Controlled Trials (CENTRAL), The Cochrane Library: contains RCTs and CCTs on any subject area in all health fields or topics that have been primarily identified in MEDLINE and EMBASE, plus handsearching of other journals and some conference proceedings not otherwise identified in searches of electronic databases. 

MEDLINE and/or EMBASE: authors may need to search for RCTs and CCTs on their specific topic to supplement what is found in the Group’s Specialised Register, or CENTRAL, particularly to identify the latest references in these databases (most recent 12 months). These databases may also be necessary if studies other than RCTs and CCTs, such as observation studies, are being reviewed. Finally, searching these databases can be useful to find articles which give an overall review of the literature on your topic. 

Search filters for Ovid SP MEDLINE, and EMBASE are available in the Cochrane Handbook at chapter 6.4.11. The Review Group’s website has filters which authors can use to identify studies involving people with chronic diseases, or in various age groups (children and adolescents, middle aged and elderly).  

Review authors should note that the Review Group requires MEDLINE strategies to be prepared using the Ovid platform; we no longer accept strategies prepared for the MEDLINE (PubMed) platform.  

Other databases: e.g. Sociological Abstracts, PsycINFO, Proquest Dissertations and Theses database, Index to Theses, etc… to identify relevant RCTs and CCTs.  

Trials registers: Authors should search clinicaltrials.gov and the WHO ICTRP portal, and other sources as appropriate. 

Other reviews, and reference lists: Authors should search within previous reviews on the same topic, and check reference lists in their review’s included studies and any relevant systematic reviews identified by their search. 
Seeking assistance

We encourage authors to consider first whether they can access local assistance (for instance at their university or hospital library). The Group’s part-time Trials Search Coordinator may also assist authors with developing or checking search strategies for MEDLINE and other databases, running a search of the Review Group’s Specialised Register, and running searches of other databases.  

At protocol stage the focus is usually on developing an appropriate search strategy for MEDLINE, which is published in the protocol on The Cochrane Library, as well as specifying other databases to be searched, and other search activity to be undertaken. (If preparing your own MEDLINE strategy, remember to save it so it can be pasted into the protocol). Formal execution of search strategies in electronic databases takes place after the protocol is approved for publication, as any changes in the review’s selection criteria may necessitate amendments to the search strategy.  

To seek assistance with developing search strategies, identifying relevant databases, or running searches please complete the request form (TSCPRO001) which is available on the Resources page of the Review Group’s website
(www.latrobe.edu.au/chcp/cochrane/resources.html), and email it to the Trials Search Coordinator (j.kis-rigo@latrobe.edu.au) together with any attachments as specified in the form.  This form provides us with the information we need to action your request in an appropriate and timely manner. The earlier authors can access help from the Trials Search Coordinator the better, as the process of refining a search strategy can be complex and time consuming. 
The Trials Search Coordinator also reviews the search strategies in each protocol when it is submitted for editorial and peer review, and will provide feedback if appropriate via the editorial review process.

Subject headings, keywords and important articles.

Many databases have particular coding systems used to index all the studies in them. For example, MeSH (Medical Subject Headings) is used to index MEDLINE. However, in addition to searching on subject headings, it is usually necessary to also search using the free text terms or words, this allowing for synonyms, American as well as British spelling, and singular forms of concepts. If requesting assistance from the Review Group, authors must examine key articles on their review topic and list 

Index terms/key words on the request form where applicable. They must also provide reference details for key articles on the request form.  

How to write up the Search Strategy section of your protocol
The write-up of the Search Strategy section in the protocol should include the databases you intend to search, the other methods of searching you will use, and at least the search strategy line-by-line of the major database you will search (usually MEDLINE), including limitations on your search (for instance, date limitations). Sample text is given below; this must be adapted for your own purposes. Note, the MEDLINE strategy should now be given in an appendix to the protocol.  


Search methods for identification of studies

Electronic Searches [recommended level 3 heading]

We will search the following electronic databases: 

· The Cochrane Consumers and Communication Review Group Specialised Register;

· The Cochrane Central Register of Controlled Trials (CENTRAL, The Cochrane Library, latest issue);

· MEDLINE (OvidSP) (date to present);

· EMBASE (OvidSP) (date to present);

· PsycINFO (OvidSP) (date to present); and 
· [List other databases].

The strategy for MEDLINE (specify platform, e.g. OvidSP)) is presented in Appendix X.  
[Insert MEDLINE strategy in Appendix to the protocol]
Strategies will be tailored to other databases and reported in the review.

There will be no language nor date restrictions [or specify any restrictions, giving reasons].  

Searching other resources [recommended, level 3 heading]

Note: The following optional headings may be used, either in place of ‘Searching other resources’ (in which case they would be level 3 headings) or as subheadings (level 4). 

Grey literature
Handsearching
Reference lists
Correspondence
We will search [list grey literature sources, such as reports and conference proceedings].  

If journals are to be specifically handsearched for the review, this should be described here in the format “We will handsearch the following journals: Title (dates), Title (dates), etc..  

We will contact experts in the field and authors of included studies for advice as to other relevant studies.  We will also search reference lists of relevant studies and (add other sources, eg. personal collections of articles).  
We will also search online trial registers (list them) for ongoing and recently completed studies.  
Specify any other search activities.  



Data collection and analysis:

This section spells out the steps of the review - who is going to do what, and according to what standards and criteria. Refer to the Cochrane Handbook section 4.5 for guidance, and note the subheadings for the Methods section listed there and also given below.
Having decided which studies are eligible for consideration, the authors need to decide which studies were done well enough. If the study was done badly, the results may not be reliable enough, so it could be excluded. This section of the protocol should make it clear how the quality of studies is going to be assessed, what the criteria are going to be, and what checks there will be on these steps. As with the selection criteria, the aim is to be so clear and specific that someone else applying the same methods would come up with more or less the same results.

NOTE: Authors must refer to the Review Group’s Study Quality Guide in preparing this section, and in particular note the suggested text on the assessment of risk of bias in included studies.  The Study Quality Guide is available at 
www.latrobe.edu.au/chcp/cochrane/resources.html. The Group’s Data Extraction Template, available at the same site, is another important resource to consider here.  

The authors should include here the statistical methods they will use if they are pooling the results of different studies, and any sensitivity or subgroup analyses they plan to do. As with outcomes, these additional analyses need to be specified up front before the review is undertaken. It is more reliable to establish reasons that there might be differences in the data before the analysis is done and then test these hypotheses than to imagine reasons for observed differences after the analysis has been undertaken.  

The authors should also consider the quality of the intervention in individual trials – see Herbert and Bø, Analysis of quality of interventions in systematic reviews, BMJ 2005; 331; 507-9.  (www.bmj.com).
Recommended subheadings, some of which you can activate using the left hand side tree view (and right clicking to choose ‘activate’) in RevMan 5, for this section of the protocol are as follows (and detailed in Chapter 4.5 of the Cochrane Handbook): 

· Selection of studies
· Authors should use at least two people working independently to determine whether each study meets the eligibility criteria, and define in advance the process for resolving disagreements. It is desirable, but not mandatory, that two people independently undertake the initial screening of titles and abstracts.  It is mandatory that the selection of studies based on full text should be done by two people independently.  
· Authors must document the selection process in sufficient detail to complete a PRISMA flow chart and a table of ‘Characteristics of excluded studies’. 
· Authors must collate multiple reports of the same study.  
· Data extraction and management
· Authors must pilot and use a data collection form, and collect characteristics of the included studies in sufficient detail to populate a table of ‘Characteristics of Included Studies’. It is desirable that at least two people working independently extract study characteristics from reports of each study, and define in advance the process for resolving disagreements. It is mandatory that outcome data are extracted independently by at least two people.  
· Assessment of risk of bias in included studies
· Authors should use the recommended text from the Review Group’s Study Quality Guide in this section.  At least two people working independently should apply the risk of bias tool to each included study.  Define in advance the process for resolving disagreements. 
· Measures of treatment effect
The following optional headings may be used, either in place of ‘Measures of treatment effect’ (in which case they would be level 3 headings) or as subheadings (level 4):
Dichotomous data
Continuous data
Time-to-event data
· Unit of analysis issues
Alternatively, optional (level 3) headings specific to the types of studies may be used, such as:
Cluster-randomised trials
Cross-over trials
Studies with multiple treatment groups
· Dealing with missing data
· Assessment of heterogeneity
· Assessment of reporting biases
· Data synthesis
· Subgroup analysis and investigation of heterogeneity
· Authors should specify potential effect modifiers, restrict these in number and provide a rationale for each. (See also ‘background’ section).

· Sensitivity analysis
· Sensitivity analysis can be used to assess the robustness of results, such as the impact of notable assumptions, imputed data, borderline decisions, and studies at high risk of bias. 
· Summary of findings table

· This section should describe the methods used to prepare any ‘Summary of findings’ tables. It should include information about (i) which populations (including  the specification of low, medium or high risk populations), interventions and comparisons are being addressed by one or more ‘Summary of findings’ tables, and why; (ii) the source of any external information used in the ‘Assumed risk’ column; (iii) a brief comment that the GRADE approach to assessing the quality of  the body of evidence is being used; and (iv) any departures from the standard methods described in Chapter 11 and Chapter 12 of the Cochrane Handbook, along with a justification for such departures. The review’s main outcomes, i.e. those intended for inclusion in the ‘Summary of findings’ table, should have been listed under the section ‘Types of outcome measures’.

· Note: this heading is not included by default within the RevMan software, but should be added by the review author.

The following further, optional (level 3) headings for the Methods section may be helpful:
Economics issues
Methods for future updates
We would also like you to outline your plans for considering consumers’ views and any consumer participation at the end of the methods section of your protocol/review, with the suggested subheading ‘Consumer participation’
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Contributions of authors: 

The contributions of the current co-authors to the protocol and review should be described in this section. One author should be identified as the guarantor of the review. All authors should discuss and agree on their respective descriptions of contribution before the review is submitted for publication on the Cochrane Database of Systematic Reviews.  Please also outline what each review author will do for the full review and who will be responsible for conducting any update of the review. Refer to the Cochrane Handbook chapter 4.5.
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Refer to the Cochrane Handbook chapter 2 and chapter 4.5.
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Sections to leave blank at protocol stage: 

Please note that within a RevMan file you see all of the headings relevant to the full review. Some of these sections must remain blank at protocol stage. Please do not complete the following sections until you are writing the full review: 

· Plain Language Summary (Synopsis).
· Abstract (and all subheadings).
· Results (and all subheadings).
· Discussion.
· Authors’ conclusions.

· References to studies (but note that ‘Other References’ should be completed and all should be cited within the text at Protocol stage).
· Characteristics of included/excluded/ongoing studies tables.
· Data and Analysis tables.
· Risk of bias and summary of findings tables.
Style of writing:

The text of the review should be clear and to the point - it should not be overly long. It should be written so that someone who is not an expert in the area can understand it. For specific guidance on matters of style refer to the Cochrane Style Guide. 



Submitting your protocol

Final checks before submitting your protocol

We ask that:

· authors read the review for grammar and spelling or nominate a review author with first language or very good English language skills to do so;
· that the Cochrane style guide is adhered to;

· that all references are completed according to the Cochrane style guide and that all are cited within the text and if not cited that they’re deleted;

· that wherever possible the review author uses the standard Cochrane headings including those that can be activated in the left hand side tree view; 

· that a validation report is run on the protocol by going to File/reports/validation report and that any errors or warnings are addressed before submitting; and
· that when submitting to the editorial team that the author follows the RevMan Wizard and choose ‘submit for editorial approval’, we recommend also that you include a note to confirm that you are submitting your protocol for editorial approval along with any details such as additional authors to be added to the review or changes to the title.

· For further information on submitting your protocol please go to chapter 5.

The Managing Editor will return your draft if it appears that the above have not been checked through.

Presubmission checklist

We require that when you submit your protocol for editorial review you also submit a completed presubmission checklist.  
The author’s presubmission checklist – protocol stage is available at: http://www.latrobe.edu.au/chcp/cochrane/resources.html
The Managing Editor will return your protocol if you have not completed a presubmission checklist

You may also find the following helpful:
Compare versions in Archie 

(This is useful when protocol/review is in the editorial process and you want to check any changes that have been made to the latest version)
To compare the latest version of your protocol/review with an earlier version of your protocol or see changes the editorial team may have made to your work: open the protocol or review ‘Properties’ (double-click on title or right-click and choose Properties)/History/highlight latest version (Hold Ctrl + highlight with your mouse the version for comparison/and click on ‘Compare’. You can print or save this ‘tracked changes’ document (diffdoc.htm) using the icon buttons in the upper left corner of the viewing screen – it will normally automatically save the version to your computer desktop. You will also see here that you can print and save the tracked changes document or the version of your choice as a PDF. 

CHAPTER 3: RESOURCES FOR AUTHORS OF REVIEWS WITH THE COCHRANE CONSUMERS AND COMMUNICATION REVIEW GROUP 
Your main resource in completing a Cochrane protocol and review is the latest version of the Cochrane Handbook for Systematic Reviews of Interventions.  
The following resources are tailored, or otherwise relevant, to authors of reviews with the Cochrane Consumers and Communication Review Group.
Cochrane Collaboration resources
Cochrane Database of Systematic Reviews and The Cochrane Library 

Cochrane Reviews are published in the Cochrane Database of Systematic Reviews (CDSR), which is one of seven databases in The Cochrane Library. In addition to the CDSR, The Cochrane Collaboration prepares three other databases: 

· Cochrane Central Register of Controlled Trials (CENTRAL), 

· the Cochrane Methodology Register, and 

· About The Cochrane Collaboration. 

The other databases in The Cochrane Library are:

· the Database of Abstracts of Reviews of Effects (DARE), 

· the Health Technology Assessment (HTA) Database, and 

· the NHS Economic Evaluation Database (EED). 

Further information is available at The Cochrane Library.

Quickstart for Authors & Top Tips for Authors using RevMan 5.1 and Archie

The Quickstart for Authors document gives a brief overview of how to manage contact details and use Archie in conjunction with Review Manager (RevMan) 5.1 to prepare a Cochrane Review. The Top Tips for Authors Top using RevMan 5 and Archie is a more detailed document which is essential reading for all authors.

Cochrane Style Guide Basics and the Cochrane Style Guide

Authors should familiarize themselves with the Cochrane Style Guide Basics, a two-page document containing essential copy-editing guidance for authors from the Cochrane Style Guide.
The Cochrane Style Guide is the full guide designed to help review authors and people responsible for copy-editing to use a consistent style when copy-editing Cochrane Reviews and other documents produced by The Cochrane Collaboration. This document can also be viewed from the Help file in RevMan 5.1.
GRADEprofiler (GRADEpro) 

GRADEpro is the software used to create Summary of Findings (SoF) tables in Cochrane Reviews. This software retrieves review data directly from a RevMan 5.1 file, combines these data with user-entered data and then prepares a SoF table ready for importing into RevMan 5.1. It performs many of the calculations necessary to present the key results of systematic reviews in table format, and it guides users through the process of grading the quality of the evidence using the GRADE approach.

Cochrane Collaboration Glossary

The Cochrane Collaboration Glossary contains definitions of research methodology terms and gives details of the structure and roles of staff within the Collaboration.

Newcomers’ guide 

The Cochrane Collaboration’s Newcomers’ guide is a collection of information resources charting the development of the Collaboration, explaining what a Cochrane Review is and giving details on how to become involved. 

CCInfo 

CCInfo is the electronic news bulletin of The Cochrane Collaboration. It enables readers to keep informed about the activities and policies of the Collaboration. Anyone can join the CCInfo mailing list.

Cochrane Collaboration news

The latest news from the Cochrane Collaboration is available via our website at www.cochrane.org, where you will find further resources, information about coming events, discussion forums, blogs and more.


Consumers and Communication Group tailored resources
These are available on our website at www.latrobe.edu.au/chcp/cochrane/resources.html. Note, these resources may also be highly-relevant to authors of Cochrane reviews with other Groups.  
· Data extraction template (note, authors must tailor the template for use in their own review/s).
· Study Design Guide.
· Study Quality Guide.
· Review Group Scope and Taxonomy of Outcomes
· Checklist for consistency

· Presubmission checklists 
Other resources
· Quality assessment of the intervention – see Herbert and Bø, Analysis of quality of interventions in systematic reviews, BMJ 2005; 331; 507-9.  

· Egger M, Davey-Smith G, Altman D. (2001). Systematic Reviews in Health Care: Meta-Analysis in Context. London: BMJ.
Papers exploring the issues involved in incorporating non-randomised studies in systematic reviews

· Deeks JJ, Dinnes J, D’Amico R, Sowden AJ, Sakarovitch C, Song F, et al. Evaluating non-randomised intervention studies. Health Technol Assess 2003;7(27).
· Shrier I, Boivin J, Steele RJ, Platt RW, Furlan A, Kakuma R, Brophy J and Rossignol M. Should Meta-Analyses of Interventions Include Observational Studies in Addition to Randomized Controlled Trials? A Critical Examination of Underlying Principles. Am J Epidemiol 2007, 166:1203–1209
Papers that investigate the issue of quality scores in meta-analysis
· Juni P, Witschi A, Bloch R, Egger M. The hazards of scoring the quality of clinical trials for meta-analysis. JAMA 1999;282(11):1054-60
· Herbison P, Hay-Smith J, Gillespie WJ: Adjustment of meta-analyses on the basis of quality scores should be abandoned. J Clin Epidemiol 2006, 59:1249-1256
Papers exploring other issues relating to meta-analysis

· Ioannidis J, Patsopoulos N and Rothstein H. Reasons or excuses for avoiding meta-analysis in forest plots. BMJ 2008, 336: 1413-1415
· Riley RD Higgins JPT, Deeks JJ. Interpretation of random effects meta-analyses. BMJ 2011; 342:d549 doi: 10.1136/bmj.d549
· Sterne JAC, Sutton AJ, Ioannidis JPA, Terrin N, Jones DR, Lau J, Carpenter J, Rücker G, et al. Recommendations for examining and interpreting funnel plot asymmetry in meta-analyses of randomised controlled trials. BMJ 2011;342:d4002 doi: 10.1136/bmj.d4002
CHAPTER 4: AUTHOR RESPONSE FORM  
AUTHOR RESPONSE TO EDITORIAL AND EXTERNAL PEER REVIEW COMMENTS ON PROTOCOL

Author name:

Review Title:

Due Date for Comments:

Response to Editorial/External Peer Review Comments

Please respond to all comments given on your Protocol, by number, noting if you accept, reject or query the comment, and stating: What changes were made in response to comments/Justification for rejection of comments or suggestions/Queries for Further Information/Further suggestion or proposal. We also suggest you copy the full comments here and respond to them in a point to point fashion within the text outlining where you have made any resulting changes to the protocol text, this further helps the editorial team see where you’ve made changes.
CHAPTER 5: EDITORIAL PROCESSES AND POLICIES, AND THE COCHRANE LIBRARY PUBLICATION DATES

During development of your protocol, please refer all queries to the Managing Editor in the first instance.  

Once you have submitted your draft protocol for editorial approval by checking it into the Archie server from RevMan 5 using the submission check-in wizard, and have emailed the completed presubmission checklist (http://www.latrobe.edu.au/chcp/cochrane/resources.html) to the Managing Editor, the protocol it will be subject to the Consumers and Communication Group standard editorial process. The Consumers and Communication Group editorial team welcomes any suggested referees that you consider appropriate to check your protocol, but will not necessarily be restricted to such suggestions and will allocate referees on the basis of subject, user and methodological knowledge relevant to your review. Draft protocols will be distributed to at least three external referees (including one consumer), to the Trials Search Coordinator and the Managing Editor, and to four members of the editorial team, including the statistics editor.

Your contact editor aims to provide collated, anonymised feedback to you within eight weeks of the protocol submission (notwithstanding events beyond our control which may delay this process). 
You are required to respond to the feedback, indicating how you have addressed each point (agree/disagree/query, and any action taken). You should return this response document to the Managing Editor, via e-mail alongside checking in your revised protocol for editorial approval.
The Contact Editor is responsible for carefully checking your amendments and may at this stage request further changes, or may recommend the protocol to the Coordinating Editor for publication.  

Once the protocol has been recommended to the Coordinating Editor, the Managing Editor copy edits it, and it may also then be sent to the copy editors at Wiley-Blackwell (our publishers).  

Following copy editing (which may require further input from you if any elements of the protocol are unclear), the protocol is submitted to the Coordinating Editor for review and final approval.  Only once the Coordinating Editor is satisfied with the accuracy and quality of the protocol, will it be approved for publication on The Cochrane Library.  

After the protocol has been approved by the Review Group, all authors will receive a proof of the final version and a link to a licence for publication form that requires electronic completion.  Only when all authors have completed the licence form, will the protocol be uploaded to Wiley-Blackwell for publication.  
Timeframes

The Review Group will liaise with you over timeframes in the lead up to publication, and will seek to adhere to all stated deadlines, notwithstanding events that may be beyond our control. Ideally, review authors should submit their draft protocol for editorial and peer review four months before the release date of the desired issue of The Cochrane Library they wish to have the protocol published in.

Since 2010, The Cochrane Library has been published on a monthly basis. Items for publication must be finalised and approved at least one month before the release date of the Library and all declarations and conflict of interest forms completed by all authors of the protocol.
While the Review Group will make every effort to meet agreed deadlines and to facilitate publication on a particular issue of The Cochrane Library, publication of a protocol or review always remains at the discretion of the Group’s editorial team and the Coordinating Editor. Publication of a protocol or review, particularly on a specific issue number of The Cochrane Library, is not guaranteed.
Authors should contact the Managing Editor Dr. Megan Prictor for further details of review timelines and publication schedules. 








































































IMPORTANT – All Consumers and Communication Group authors MUST seek advice from the Trials Search Coordinator John Kis-Rigo in preparing an OvidSP MEDLINE strategy for inclusion in the protocol, irrespective of whether they have search expertise within, or easily accessible by, their team. Authors should prepare their protocol’s selection criteria, complete the form at: � HYPERLINK "http://www.latrobe.edu.au/chcp/assets/downloads/TSCprotocol.doc" ��www.latrobe.edu.au/chcp/assets/downloads/TSCprotocol.doc� and send it to John (� HYPERLINK "mailto:j.kis-rigo@latrobe.edu.au" �j.kis-rigo@latrobe.edu.au�).  
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